
 

Overview Guide 
r8 

CA ERwin® Data Modeler 

 

 

 

 



 

 

This documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred to as 
the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by CA at any time. 

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without 
the prior written consent of CA. This Documentation is confidential and proprietary information of CA and may not be disclosed 
by you or used for any purpose other than as may be permitted in (i) a separate agreement between you and CA governing 
your use of the CA software to which the Documentation relates; or (ii) a separate confidentiality agreement between you and 
CA.  

Notwithstanding the foregoing, if you are a licensed user of the software product(s) addressed in the Documentation, you may 
print or otherwise make available a reasonable number of copies of the Documentation for internal use by you and your 
employees in connection with that software, provided that all CA copyright notices and legends are affixed to each reproduced 
copy.  

The right to print or otherwise make available copies of the Documentation is limited to the period during which the applicable 
license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to 
certify in writing to CA that all copies and partial copies of the Documentation have been returned to CA or destroyed.  

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY 
KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, 
DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST 
INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED IN ADVANCE OF THE 
POSSIBILITY OF SUCH LOSS OR DAMAGE. 

The use of any software product referenced in the Documentation is governed by the applicable license agreement and such 
license agreement is not modified in any way by the terms of this notice. 

The manufacturer of this Documentation is CA.  

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions 
set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or 
their successors.  

Copyright © 2011 CA. All rights reserved.  All trademarks, trade names, service marks, and logos referenced herein belong to 
their respective companies. 

 



 

CA Technologies Product References 

This document references the following CA Technologies products: 
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■ CA ERwin® Data Modeler Workgroup Edition (CA ERwin DM WE) 
 



 

Contact CA Technologies 

Understanding your Support 

Review support maintenance programs and offerings. 

Registering for Support 

Access the CA Support online registration site to register for product support. 

Accessing Technical Support 

For your convenience, CA Technologies provides easy access to "One Stop" support for 
all editions of CA ERwin Data Modeler, and includes the following: 

■ Online and telephone contact information for technical assistance and customer 
services 

■ Information about user communities and forums 

■ Product and documentation downloads 

■ CA Support policies and guidelines 

■ Other helpful resources appropriate for your product 

For information about other Home Office, Small Business, and Enterprise CA 
Technologies products, visit http://ca.com/support. 

Provide Feedback 

If you have comments or questions about CA Technologies product documentation, you 
can send a message to techpubs@ca.com. 

If you would like to provide feedback about CA Technologies product documentation, 
complete our short customer survey, which is also available on the CA Support website, 
found at http://ca.com/docs.  

CA ERwin Data Modeler News and Events 

Visit www.erwin.com to get up-to-date news, announcements, and events. View video 
demos and read up on customer success stories and articles by industry experts. 
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https://support.ca.com/prodinfo/supportregistration
https://support.ca.com/prodinfo/erwin
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Chapter 1: Introduction 
 

This Overview Guide is targeted for Data Architects, Data Administrators, Application 
Administrators, Database Administrators, and Partners who are planning to upgrade 
from CA ERwin Data Modeler r7.x and want to learn about the new features of r8.  

CA ERwin Data Modeler r8 has many new features accompanied by changes to the user 
interface. Use the guided tours described in this guide to become familiar with these 
features and changes. This guide provides you with a framework of understanding to 
implement future releases, which will expand on the features introduced in this release. 

While working in CA ERwin Data Modeler during a tour, if you need additional 
information about the feature, click the Help button on the toolbar or press F1 to open 
the online help. 
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Chapter 2: Guided Tours 
 

This section contains the following topics: 

Diagrams, Subject Areas, Layout, and Customization (see page 9) 
New Database Support (see page 19) 
Bulk Editor and Bulk Editor Wizard (see page 23) 
Reporting (see page 26) 
Spell Checker, History, Notes, Printing, Transforms, Link Objects, and Navigation (see 
page 29) 

 

Diagrams, Subject Areas, Layout, and Customization 

This section provides information about the following functional areas: 

Basic menu and toolbar customizations (see page 10) 

Advanced menu and toolbar customizations (see page 10) 

Workspace customization (see page 11) 

Diagram and subject area properties (see page 12) 

Creating, maintaining, and working with model objects (see page 14) 

Annotation and connector objects (see page 15) 

Model layout and navigation (see page 16) 

Creating and working with themes (see page 17) 
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Basic Menu and Toolbar Customizations 

Use the following steps to become familiar with basic toolbar customization. 

1. Open CA ERwin Data Modeler. 

2. Left-click the Down arrow at the right-hand bottom corner of any displayed toolbar 
to display the Add or Remove Buttons menu. Slide your cursor over this menu and a 
submenu should appear. Place your cursor over any of the displayed toolbars and 
modify the tools displayed on that toolbar by clicking on the specific tool (to turn on 
or off). 

Note: Your changes should be reflected in real-time on the displayed toolbar.  

3. Make changes to several of the toolbars by following the process outlined in Step 2. 

4. Undo one or more of your toolbar customizations by selecting the Reset Toolbar 
button at the bottom of any of the Add or Remove toolbar submenus. You should 
see the reset action reflected in real-time on the displayed toolbar. 

 

Advanced Menu and Toolbar Customizations 

Use the following steps to become familiar with advanced toolbar customization. 

1. Right-click in the toolbar area and select the toolbars that you want to display at the 
top of the screen. 

2. Click Customize to open the toolbar and menu customization dialog. Click the 
Toolbars tab and feel free to create (New button), rename (Rename button), and 
delete (Delete button) one or more toolbars.  

Note: You can use practice toolbars, not the predefined CA ERwin Data Modeler 
toolbars. Also, you can always use the Reset button to the reset the changes made 
to the menu or existing toolbars to reflect the product default settings. 

3. Click the Commands tab to see the complete list of all the commands that can be 
added to the toolbars and menu. Add one or more commands to your choice of 
toolbar. Using this same dialog, add one or more commands to the CA ERwin Data 
Modeler menu. 

 

4. Click the Keyboard tab and assign a new shortcut key to one or more commands 
available in the different menu categories. You can experiment by removing or 
resetting the changes made. 

5. Click the Options tab to further personalize the menus and toolbars as needed. You 
can modify settings to see full menus, large icons, or screen tips on toolbars. 

6. While you are still in the Customize dialog, right-click any menu, menu item, or 
displayed toolbar icon to open a menu of advanced object-specific property 
customizations. You can experiment with any of these customizations. 
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Workspace Customization 

Use the following steps to become familiar with workspace customization. 

1. Click View, Windows and specify the window panes you want to see or hide by 
selecting or deselecting them on this submenu. 

2. If a pane, such as the Model Explorer, is visible only as a tab, it is considered hidden. 
Hover your mouse cursor over a hidden pane’s tab to unhide the pane. Then, click 
the “push-pin” icon  at the upper right corner of the now visible pane. Doing so 
turns the push-pin icon vertical  and docks the selected pane. Now you can 
continue. 

3. When a pane, such as the Model Explorer, is visible on your workspace you may 
select it and drag it by clicking and holding the title bar.  

Note: The selected pane undocks from the workspace border to become a floating 
window. Try doing this with the Action Log pane. 

4. Holding the Action Log Pane as selected in Step 3, notice the appearance of the 
dropping guides that indicate the available docking locations. Move your mouse 
cursor over any of the docking locations; the area where the pane will dock along 
the workspace border is highlighted. Release the mouse button, and the pane is 
docked in that location. 

 

5. If the window panes are already docked together and appear as tabs in a single 
docking pane, click and drag an individual tab and drop it anywhere in the 
workspace to create a standalone floated or docked pane. To dock panes together 
in a pane group (that is, they combine to create multiple tabs in a single dockable 
pane), drag one pane over another and select the center icon on the docking guide. 
Create a pane group using the Action Log and the Advisories panes. 

6. Click and drag the Overview pane over the Bulk Editor pane, and select one of the 
edge targets of the docking guide that appears within the Bulk Editor pane. Notice 
how the panes have been grouped together in a single pane separated by a splitter. 
You can now auto-hide either of the combined panes (click the push-pin icon so it 
becomes horizontal) while leaving one of the panes docked. When your mouse 
hovers over the hidden pane’s tab, the pane will slide out so you can make use of it. 

7. You can close CA ERwin Data Modeler after customizing your workspace the way 
you want using the previous steps. Now open CA ERwin Data Modeler again, and 
verify that all of the window panes are in the same position as you had customized 
them before closing the application. 
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Diagram and Subject Area Properties 

Use the following steps to become familiar with the new diagram and subject area 
properties. 

1. Create a new model. Select the Subject Area tab in the Model Explorer and note 
that NO “Main Subject Area” has been created – unlike when using older versions 
of CA ERwin Data Modeler (r8 does not require that a model contain any subject 
areas. Also, both the model and subject areas may own diagrams although the 
presence of diagrams is completely optional). Now select the Model tab in the 
Model Explorer. 

2. Create four entities in the model using the Model Explorer (right-click the Entities 
category and select New).  

Note: The entities created do not automatically display on the visible diagram. 

3. In the Model Explorer, right-click one of the new entities you created. From the 
submenu displayed, select Add To Diagram and the entity becomes visible on the 
diagram. Create another new entity by selecting the Entity Tool on the toolbar and 
then clicking on a blank area within the diagram.  

Note: This new entity is automatically added to the diagram and to the Model 
Explorer. 

4. Right-click on a blank area within the diagram and click Properties from the pop-up 
menu to launch the Diagram Editor. Select the Members tab and note that the two 
entities visible on your diagram display in the Included Objects list and the three 
remaining entities display in the Available Objects list. Add one or more available 
entities to your diagram and close the editor to verify your changes. You may have 
to move entities around to see them all as some overlap may occur.  

Note: Diagrams can only display model objects that belong to the diagram’s owner 
(either the Model or a Subject Area). 
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5. Add one or more key and non-key attributes to each of the entities visible on your 
diagram and connect the entities using a mixture of identifying and non-identifying 
relationships. Open the Diagram Editor and turn on display of Data Type and Null 
Option on the Entity tab (Display Attribute Data Type and Display Attribute Null 
Option) and/or the Table tab (Display Column Data Type and Display Column Null 
Option). Close the Diagram Editor and examine the effect of your selections. 

6. Reopen the Diagram Editor and select Show Attributes/Columns as Grid on either 
the Entity or the Table tab. Close the Diagram Editor and verify the effect of this 
new selection. Explore the additional diagram options available within the Diagram 
Editor (these include options for display, print, and page setup). 

7. Create a new subject area using the Model Explorer (right-click the Subject Areas 
category and select New) and then enter “Test” as the name for your new subject 
area (SA). Right-click “Test” and click Properties from the pop-up menu to open the 
Subject Area Editor. On the Members tab select the three entities from the 
Available Objects list to be included in the subject area (must be moved to the 
Included Objects list). Close the Subject Area Editor and observe the results of your 
actions. 

8. While still viewing your new SA diagram, create a new diagram (refer to Step 4) and 
name this diagram “One Entity” by clicking on the diagram name in the upper 
portion of the dialog and typing the new name. Add one of your entities to this 
diagram, close the Diagram Editor and view the result.  

Note: You can easily switch between diagrams by selecting the appropriate named 
tab at the bottom left of your workspace. 

9. Create a new diagram in the "Test" SA using Model Explorer (right-click ER Diagrams 
and select New), and add some entities to the diagram (see step 8). You can easily 
switch between diagrams within a subject area by selecting the tab containing the 
diagram name (at the bottom left of the workspace). 

10. Save your model to use later. 
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Creating, Maintaining, and Working with Model Objects 

Use the following steps to become familiar with creating, maintaining, and working with 
model objects. 

1. Open an existing model or create a new model. Right-click on the diagram area and 
click Properties to launch the Diagram Editor. Click the Relationship tab. 

2. Select the Display Logical Relationship Name and Display Physical Relationship 
Name properties on this tab if they are not already selected. 

3. Click the Layout tab. Select the Show Callout property in the Visual Cues section and 
click Close. 

4. Grab any relationship name on the diagram and move around. Observe the 
appearance of a dashed line which connects the relationship name to the 
relationship line on the diagram. 

5. Reopen the Diagram Editor and click the Relationship tab again. Clear the Display 
Relationships check box and click Close. Observe that all the relationships in the 
current diagram are hidden. 

 

6. Reopen the Diagram Editor and select the Display Relationships property again. 
Click the Members tab and ensure the Automatically populate from Subject Area 
property is not selected, and only the required entities/tables are included in the 
current diagram. Click the Relationships tab. 

7. Include or exclude relationships for display in the current diagram by making the 
appropriate selections from the available relationships list on this tab. Exclude all 
the relationships from the diagram by clicking the Move all objects to Available 
Objects toolbar command under the Included Relationships section. 

8. Select only one relationship from the list of Available Relationships and include it in 
the diagram by selecting Move selected objects to Included Objects toolbar 
command. Click Close and observe the effect of these changes on the diagram. 
Close the current model. 

9. Create a new logical model and create two entities. Join the two entities with an 
identifying relationship. Create a third entity to the right of first two entities, and 
arrange the three entities so that they are spread out across in a horizontal line. 

10. Grab the relationship line and try to spread its edges to the right, so that the 
relationship line loops around the third entity. Notice that in the process of 
expanding the relationship line, you will be able to create multiple bend points on 
the line. Play around with the relationship lines and close the model.  
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Annotation and Connector Objects 

Use the following steps to become familiar with annotation and connector objects. 

1. Create a new logical model. Right-click the toolbar area and make sure that the 
Drawing and Toolbox options are selected to display the corresponding toolbars. 

2. Click the Annotation object  on the Toolbox toolbar, then click the diagram. Enter 
some text in the rectangle created to denote it as an annotation. Similarly, click the 
Rectangle object on the Drawing toolbar, place it on the diagram, and enter some 
text in it. 

3. In the Model Explorer, observe that the Annotation object is created as a 
model-level object, whereas the Rectangle object is created as a shape object 
within the default model-level ER Diagram. 

4. Create a new subject area called ‘SA1’ and launch the Subject Area Editor from the 
Model Explorer. Click the Members tab and observe that the Annotations object is 
present in the Available Objects list. Include the Annotation object in the subject 
area SA1 and click Close. 

 

5. From the Model Explorer, launch the Diagram Editor for the default diagram SA1. 
Click the Members tab and include the Annotation object in the diagram and click 
Close. Make sure that the diagram to which the Annotation object has been added 
is the current diagram. 

6. Right-click the Annotation object in the current diagram and click Properties to 
launch the Annotation Editor. Click the Style tab and select a Theme of your choice 
from the Optional Theme drop-down, to apply on the Annotation object. 

7. Click the Where Used tab and note that all the subject areas and diagrams where 
the current Annotation object has been used are listed. Click Close to save your 
changes. 

8. Create a new entity in the current diagram and connect it to the Annotation object 
using the Connector shape (available in the Drawing toolbar), just like creating a 
new relationship between two objects. 

9. Move around the objects connected using the Connector, or layout the diagram 
again using one of the Auto-Layout options. Observe that the Connector does not 
lose its connections with the objects it connects. Close the model. 
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Model Layout and Navigation 

Use the following steps to become familiar with model layout and navigation. 

1. Open an existing model (or create one) that contains at least 10 entities/tables. If 
you are creating a new model make sure to include attributes and relationships. 
Left-click on a blank area of the visible diagram to ensure that no model object is 
currently selected. 

2. Click Layout, Circular on the Diagram menu or click the  toolbar icon and review 
the effect of this selection. Notice that annotations connected to model objects stay 
connected even after the diagram layout is changed. 

3. Perform Step 2 again, this time selecting a different model layout option – until you 
have tried all five layout options that are available. 

4. Select a subset of the visible model objects on the diagram, apply any of the five 
model layout options and note the effect this has on your diagram. 

 

5. Next, open the Overview pane (click Windows, Overview Pane on the View menu) if 
it is not already open. Note the marquee rectangle that designates the drawing area 
that is visible in the drawing workspace. Interactively move and resize this rectangle 
to pan to a different area of the drawing and to change the viewing zoom factor. 
Auto-hide (use the "push-pin” icon ) this pane for use later. 

6. Modify the zoom percent value (between 1% and 200%) of the diagram by dragging 
the zoom bar at the bottom right-hand corner of the application. You can 
alternatively increase or decrease the zoom by clicking on the plus or minus signs at 
the ends of the zoom bar. 

7. Select an entity in the diagram and resize the entity to make the diagram object 
either extremely large or extremely small. Right-click the entity and select Reset 
Object to Automatic Sizing and observe that the entity is resized exactly to the size 
of contained text. 

8. Select any relationship on the diagram and drag the relationship line arbitrarily to 
make it extremely long. Right-click the relationship line and select Reset 
Relationship Path and observe that the relationship line is set to the least distance 
between the connecting entities. 
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Creating and Working with Themes 

Use the following steps to become familiar with creating and working with themes. 

1. Open an existing model (or create a new one) and click Themes on the View menu 
to launch the Theme Editor. 

2. Click New  on the Theme Editor toolbar to create a new theme. Notice that a new 
theme is created with a default name and property values. 

3. Click the Name field of the newly-created theme and provide a meaningful name 
such as MyTheme. Customize your new theme by specifying non-default values for 
the Default Font, Diagram Fill, Entity Font, Entity Fill, Attribute Font, and FK 
Attribute Font options in the grid. Click the tabs for other modeling objects like Key, 
View, Relationship, and so on, and customize their font and fill options if required. 
Close the Theme Editor to save your changes. 

 

4. Open the Diagram Editor, click the General tab, and select your new theme from 
the Optional Theme drop-down to apply the theme to the visible diagram. Close the 
Diagram Editor to see the effect of your selection. 

5. Right-click an entity on the diagram, and select Entity Properties to launch the 
Entity Editor. On the Style tab, change the Theme selection from the currently 
selected one to the Default Theme, and close the editor. Note the effect of this 
action on the selected entity only. 

6. Reopen the Theme Editor (see Step 1). Select the theme you created in Step 3, and 
click the Where Used tab to see the subject areas, diagrams, modeling objects, and 
drawing objects that use this particular theme. Verify the places where this theme 
is being used, and close the editor. 
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Tour 1 Questions and Feedback 

Work with the following questions for Tour 1 to assess your understanding of the 
features. 

1. Did the toolbar customization work as expected? Were you able to successfully 
create new toolbars, add/remove buttons to them and assign new shortcut keys to 
them? 

2. In addition to the process stated for launching the Diagram Editor (right-click on a 
blank area of a diagram and click Properties) what are two other ways to 
accomplish this same task? 

3. Do the five model layout options work as expected? Did you perform a model 
layout after selecting a subset of the visible model objects? If so, what was the 
effect? 

4. What, if any, additional model layout functionality would you like to see 
incorporated in CA ERwin Data Modeler? 

5. How was your experience working with themes? Did you apply themes to subject 
area and individual diagrams? Were the changes reflected in the diagram according 
to the theme applied? Do you have any suggestions to make themes work better 
according to your requirements? 

6. Did the Link Objects work as expected? Were you able to successfully create the 
Link Object and control the properties of the target column by changing the 
properties of the source column? Can you differentiate between the Link Objects in 
this release and Column Denormalization in the previous releases? 

Contact us to provide feedback, comments, or questions about the features covered in 
this tour. 

 

mailto:Team-RMDM-ERwin@ca.com
mailto:Team-RMDM-ERwin@ca.com
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New Database Support 

This section provides information about the following functional areas: 

DB2 table support in a new model (see page 19) 

DB2 column support in a new model (see page 20) 

DB2 support using an existing database or script (see page 20) 

DB2 support in an existing model (see page 21) 

DB2 index support in a new or existing model (see page 21) 

DB2 XML index support in a new or existing model (see page 21) 

Additional database support - SQL Server 2008 and Teradata 13 (see page 22) 

Schema validation (see page 22) 
 

DB2 Table Support - New Model 

Use the following steps to become familiar with DB2 table support in a new model. 

1. Create a new DB2 (z/OS or LUW) v9.x model. 

2. Add several entities to the model and populate with attributes using on-screen 
editing. Connect with relationships as needed. 

3. Open the Entity, Attribute, and Key Group editors. Review and familiarize yourself 
with the layout of information available on all of the tabs in these editors. 

4. Create a definition in one of these editors and check the spelling of your entered 
text. 

5. Create one or more note entries. 
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6. Press F1 or the Help icon to access the context-level help for any of these editors. 
Review the help text and then close the online help. 

7. Access the physical side of your model (if you created a Logical/Physical model) or 
derive a physical model (if you created a Logical-only model). 

8. Open the Table Editor and review and familiarize yourself with the physical 
properties available on all of the tabs. 

9. Assign your tables to different tablespaces (you will have to create the tablespaces 
first). 

10. From within the Table Editor, access the Permission Editor (click the Permission 

Editor icon  on the Permission tab). 

11. Create several new permissions and close the Permission Editor. 

12. Associate one or more of your permissions to one or more of your tables, and close 
the Table Editor, but do not save the model just yet. 

 

DB2 Column Support - New Model 

Use the following steps to become familiar with DB2 column support in a new model. 

1. Open the Table Column Editor and review and familiarize yourself with the 
information available on all of the tabs. 

2. Click the Database tab and validate the database-specific properties, including the 
available data types. 

3. Explore and modify the information within this editor as you would normally do as 
part of your daily activities. 

4. Close the Table Column Editor and save this model. 
 

DB2 Support - Existing Database or Script 

Use the following steps to become familiar with DB2 support for reverse-engineering 
using an existing database or script. 

1. Reverse-engineer an existing DB2 (z/OS or LUW) v9.x database or script. 

2. Browse this new model and review the physical properties created (table, column, 
index, and so on) paying careful attention to those properties not available in prior 
versions of CA ERwin Data Modeler. 

3. Note any inconsistencies and discrepancies. 

4. Make any changes you want to the physical properties of this new model using any 
of the editors available. 

5. Close any open editor and save this model. 
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DB2 Support - Existing Model 

Use the following steps to become familiar with DB2 support in an existing model. 

1. Open an existing CA ERwin Data Modeler r7.3 DB2 (z/OS or LUW) data model. 

2. Browse the migrated model and review the physical table properties (nothing 
should exist except for those properties available in the prior product release). 

3. Note any inconsistencies and discrepancies. 

4. Based on your knowledge of this model, set the Table, Column, Tablespace, and 
Permission properties. 

5. Make any changes you want to the physical properties of this model using any of 
the editors available. 

6. Close any open editor and save this model. 
 

DB2 Index Support - New or Existing Model 

Use the following steps to become familiar with DB2 index support in a new or existing 
model. 

1. Right-click on any table in either a new or existing model and click Index Properties 
on the pop-up menu. 

2. Review and familiarize yourself with the index properties available on all of the 
tabs. 

3. Based on your knowledge of DB2 and this model, freely create and set the index 
properties for the selected table. 

4. Change the table and repeat Step 3 as often as you wish. 

5. Close the Table Index Editor, but do not close or save the model just yet. 
 

DB2 XML Index Support - New or Existing Model 

Use the following steps to become familiar with DB2 XML index support in a new or 
existing model. 

1. Right-click on any table in a new or existing model and click XML Index Properties 
on the pop-up menu. 

2. Review and familiarize yourself with the XML index properties available on all of the 
tabs. 

3. Based on your knowledge of DB2 and this model, freely create and set the XML 
index properties for the selected table. 

4. Change the table and repeat Step 3 as often as you wish. 

5. Close the Table XML Index Editor, but do not close or save the model just yet. 
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Additional Database Support - SQL Server 2008 and Teradata 13 

Use the following steps to become familiar with SQL Server 2008 and Teradata 13 
support. 

1. Perform any of the steps described previously for DB2 using SQL Server 2008 
models and applicable editors instead. 

2. Perform any of the steps described previously for DB2 using Teradata v13 models 
and applicable editors instead. 

3. Close any open editor and save any open models. 
 

Schema Validation 

Use the following steps to become familiar with schema validation. 

1. Open one of your DB2 v9.x, SQL Server 2008, or Teradata v13 models containing 
newly-supported physical properties and indexes (modified in previous steps). 

2. Click Forward Engineer, Schema on the Actions menu or click the Forward Engineer 

Schema Generation icon  on the toolbar. 

3. Click the Preview button and review the SQL generated for errors or other issues. 

4. Click Generate (catalog or script), and note any issues. 

5. Click Close and then click OK to exit the Forward Engineer Schema Generation 
dialog. 

6. Repeat steps 1 through 5 as needed. 
 

Tour 2 Questions and Feedback 

Work with the following questions for Tour 2 to assess your understanding of the 
features. 

1. Did the Table Editor, the Column Editor, the Tablespace Editor, and the Permission 
Editor contain all of the properties and options you expected to find? 

2. Did the Index Editor and the XML Index (DB2) Editor contain all of the properties 
and options you expected to find? 

3. What properties or options are missing (and in which editor) that you expected to 
find? 

4. Did Schema Generation produce the SQL you expected and is it correct? 

5. Did the online help provide clear information and is it easy to navigate? 

Contact us to provide feedback, comments, or questions about the features covered in 
this tour. 

 

mailto:Team-RMDM-ERwin@ca.com
mailto:Team-RMDM-ERwin@ca.com


Bulk Editor and Bulk Editor Wizard 

 

Chapter 2: Guided Tours  23  
 

Bulk Editor and Bulk Editor Wizard 

This section provides information about the following functional areas: 

Bulk Editor Wizard (see page 23) 

Basic Bulk Editor operations (see page 24) 

Working with CSV files (see page 25) 
 

Bulk Editor Wizard 

Use the following steps to become familiar with the Bulk Editor Wizard. 

1. Open one of your existing models and launch the Bulk Editor pane (if it is not 
already displayed) by clicking Windows, Bulk Editor Pane on the View menu. 

2. Click the Bulk Editor Wizard icon  on the Bulk Editor toolbar to open the Bulk 
Editor Wizard. 

3. Read the information in the Overview page to understand the process of using the 
wizard and the information contained in the other pages of the wizard. You can also 
press F1 or the Help button to access the online help specific to this wizard. 

4. Click the Object Types page from the list on the left side. Select one or more of the 
object types listed (such as Table or Column) for display/editing in the Bulk Editor. 
You can experiment with the toolbar on this page to filter the object list display or 
select or clear your choices. 

5. Click the Property Types page from the list on the left side. Select one or more of 
the property types listed (such as Comment, Definition, Name) for display/editing in 
the Bulk Editor. You can experiment with the toolbar on this page to filter the 
property type display or select or clear your choices. 

Note: The property types displayed are those that are common to all the object 
types selected in Step 4. 
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6. Click the Object Instances page from the list on the left side. Expand each grouped 
object “set” and select all or a subset of the object type instances listed on this page 
for display/editing in the Bulk Editor. You can experiment with the toolbar on this 
page to facilitate this selection process. 

7. Click the Display Order page from the list on the left side. Use the toolbar buttons to 
arrange the Bulk Editor output row ordering by selected Object Types and the 
column ordering by selected Property Types. 

8. Click the User Settings page from the list on the left side. Familiarize yourself with 
these optional configuration settings and feel free to experiment. 

9. In Steps 4, 5, and 6 you can save your Object Types, Property Types, and Object 
Instances to an Option Set (similar to Option Sets in Complete Compare).  

Note: You can only save Object Instances in your Option Set when the Option Set is 
saved in the ‘current’ model. Saved external XML Option Sets only contain Object 
Types and Property Types. 

10. Once you are satisfied with the selections made in the previous steps, click the Edit 
button to close the wizard and return to the Bulk Editor pane that now contains the 
model metadata based on your selection criteria. 

 

Basic Bulk Editor Operations 

Use the following steps to become familiar with basic Bulk Editor operations. 

1. Using the vertical “splitters” between the displayed column headers feel free to 
adjust the width of any displayed column for better viewing of the selected 
metadata.  

Note: Clicking on a column header will override the row ordering you specified in 
the Bulk Editor Wizard and sort the row-level metadata either alphabetically or 
reverse alphabetically. 

2. Click in a metadata cell (such as Name or Comment) and make some in-line edits. 

Click the  icon to open a larger editing window so you can change the metadata 
value.  

Note: You can launch the macro toolbox (via the menu icon) to include macros in 
your changed metadata. When you complete your change, click the OK button to 
close the window and display your change in the Bulk Editor. 

3. Enter text in the search box at the top of the Bulk Editor (search box reads: “Enter 
filter text”) to search for and limit the Bulk Editor display to only those rows 
containing the entered text.  

4. Enter a new (or updated) comment (or similar) value on the first row displayed. 

5. Right-click on the updated comment (or similar) value and then select Copy this cell 
on the pop-up menu. 
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6. Using standard Windows selection keystrokes select several or all displayed rows.  

Note: Use the first column in the Bulk Editor to do this. 

7. Right-click on any one of the selected rows and then select Paste to...all selected 
rows on the pop-up menu to populate the change made in Step 4 to all selected 
rows. 

8. Remove the filter criteria entered in Step 3 (delete the entered search value) and 
verify the changes made in Step 7 did not update any non-displayed rows.  

Note: You can use Undo/Redo for this purpose. 

9. Select one of the table objects displayed in the Bulk Editor that is also visible in the 

modeling workspace. Click the  icon (Edit the selected object) to open the Table 
Editor. In the Table Editor, click the Delete toolbar icon to delete the selected object 
from the Bulk Editor pane – it should also disappear from your modeling workspace. 
Close the Table Editor to return to the Bulk Editor. 

10. Click the  icon to undo the previous Delete operation and verify that both the 
Bulk Editor and the modeling workspace are properly updated. 

 

Working with CSV Files 

Use the following steps to become familiar with working with CSV files. 

1. Click in the leftmost cell on row 1 (for example, row 1, column 1 – “Name”) to select 
row 1, then press Ctrl A to select all rows in the Bulk Editor window. 

2. Click the Save selected rows to .csv file toolbar icon and save the Bulk Editor 
metadata result set to an external .csv file. 

3. Update the .csv file by adding missing metadata and/or updating existing metadata. 

4. Import your changes back into your open model using the Import model updates 
from .csv file toolbar icon. Confirm that the changes made are reflected in both the 
Bulk Editor window and the model itself. 
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Tour 3 Questions and Feedback 

Work with the following questions for Tour 3 to assess your understanding of the 
features. 

1. What do you feel about the Bulk Editor functionality? Does it help you with bulk 
metadata access and modification? 

2. Does the Bulk Editor work as expected according to this tour? Is there something 
not working correctly? 

3. Is the Bulk Editor Wizard straightforward and easy to use? Would you like to 
provide any suggestions to improve the Bulk Editor Wizard options? 

4. Is all of the metadata displayed correctly in the Bulk Editor pane? Are changes made 
to the metadata in the pane reflected back in the model? 

5. Are the Bulk Editor pane menu icons working as expected? Were you able to 
successfully perform copy-paste-delete operations on the result set? 

6. Were you able to successfully export and import metadata to .csv files? Did the 
changes made by you to the .csv file reflect correctly in the model on import? 

7. Do you feel the Bulk Editor provides the same level of functionality and ease of use 
for metadata access and modification, as was provided by Data Browser? 

8. Is the Bulk Editor context-sensitive help useful? Were you able to find answers on 
all of your questions in the help file? 

Contact us to provide feedback, comments, or questions about the features covered in 
this tour. 

 

Reporting 

This section provides information about the following functional areas: 

CA ERwin Report Viewer (see page 27) 

Diagram integration with Crystal Reports (see page 27) 

Mart reporting with Crystal Reports (see page 28) 
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CA ERwin Report Viewer 

Use the following steps to become familiar with working with the CA ERwin Report 
Viewer. 

1. Open one of your existing models and launch the pinned report Logical-Physical 
Combined Dictionary.rpt on the Tools, Pinned Reports menu. This launches the CA 
ERwin Report Viewer. 

2. In the Enter Parameter Values dialog, select one or more Subject Areas to report on 
and an appropriate Column Ordering. Click OK to generate the report. 

3. Browse the report generated and verify the dictionary information against your 
model. Use the Group Tree on the left side to quickly jump to a particular entity in 
the report. 

 

4. Switch back to CA ERwin Data Modeler, and change the definition of one of the 
entities in the current diagram. In the CA ERwin Report Viewer, click the Refresh 
toolbar button  to reload the model information. Select the parameter values 
and click OK. Note that the change in definition is also reflected in the report. 

5. In the CA ERwin Report Viewer, select Edit, Edit Design (or press Ctrl+E) to launch 
Crystal Reports Developer to edit the report. Format the report in the Design tab, 
and click Refresh to see the results of the new report. 

6. Save your changes and exit Crystal Reports Developer. Close the CA ERwin Report 
Viewer. 

 

Diagram Integration with Crystal Reports 

Use the following steps to become familiar with diagram integration with Crystal 
Reports. 

1. Open one of your existing models and launch the pinned report Current Diagram 
Membership (Logical).rpt on the Tools, Pinned Reports menu (through CR 
Developer). This launches Crystal Reports Developer. 

2. Execute the report from the menu option Report, Refresh Report Data (or press F5), 
and observe the current diagram’s image in the report output. Close the Current 
Diagram Membership report (and not Crystal Reports Developer). 

3. Select the menu option File, New, Standard Report (or press Ctrl+N) to launch the 
Standard Report Creation Wizard. Select and double-click the CURRENT_DIAGRAM 
table under My Connections, ERwin_Current, Current, DGM, CURRENT_DIAGRAM 
to include the CURRENT_DIAGRAM in the Selected Tables list and click Finish. 

4. On the Design tab, insert a new OLE Object from the menu option Insert, OLE 
Object and selecting the option Object Type as Bitmap Image. Click OK and click 
anywhere on the report area to drop the image rectangle. Close the image editor by 
clicking anywhere on the report area. 
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5. Right-click the OLE Object and select Format Graphic to launch the Format Editor 
dialog. On the Picture tab, click the Graphic Location command button to launch the 
Formula Workshop dialog. Select ENTIRE_MF under the ERwin_Current, 
CURRENT_DIAGRAM by double-clicking the same and click Save and Close (top left 
corner). Click OK in the Format Editor dialog. 

6. Refresh the Report (see Step 2), and note that the latest image of the current 
diagram is fetched in the result. 

7. Go back to CA ERwin Data Modeler and change the position of some of the entities 
in the current diagram. Alternatively, you can switch to a new diagram. Return to 
Crystal Reports Developer and click Refresh. Observe that the latest image of the 
current diagram is fetched and displayed in the report. 

8. Save your changes and exit Crystal Reports Developer. Close CA ERwin Report 
Viewer. 

 

Mart Reporting with Crystal Reports 

Use the following steps to become familiar with mart reporting with Crystal Reports. 

1. Connect to your mart by clicking Mart, Connection on the File menu if you are not 
already connected. Enter your login credentials and details of the mart database in 
the Connection Manager dialog, and click Connect. 

2. Click Model Manager Reports, Global Reports on the Tools menu and launch the 
Libraries Diagram Entity report. This launches CA ERwin Report Viewer. 

3. Enter your mart Login ID and password in the Database Login dialog and click Finish. 
Note that the selected report is executed and the result is displayed in the CA ERwin 
Report Viewer. 

 

4. Verify the result of the report against the libraries, diagrams, and entities in your 
mart. Make some changes to your mart hierarchy and Refresh the report to see the 
changes reflected in the report output. 

5. Click Export, Export Report on the File menu to export the report contents in an 
external file format. Select PDF or any other format from the Export dialog and click 
OK. Select ‘All’ Page Range in the Export Options dialog and click OK. Enter a file 
name and provide a file path and click Save. Open the PDF file created and verify 
the contents of the report generated. 

6. Switch back to CA ERwin Data Modeler and explore the other reports present in 
Global Reports (see step 2). Execute some more reports and observe the results. 
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Tour 4 Questions and Feedback 

Work with the following questions for Tour 4 to assess your understanding of the 
features. 

1. Is the report generated in CA ERwin Report Viewer correct and contain all of the 
expected model metadata? 

2. Do the Pinned Reports provided fulfill your requirements to the same level as Data 
Browser and Report Template Builder? Are there any additional Pinned Reports you 
would like to see? 

3. Are the report formatting and content-displaying capabilities of Crystal Reports 
better than what was provided by CA ERwin Data Modeler in the past? 

4. Were you able to successfully design your reports in Crystal Reports Developer after 
studying the Pinned Reports provided in CA ERwin Data Modeler? 

5. Is the diagram generation capability of Crystal Reports sufficient for your 
requirements for reporting? What additional capabilities would you like for diagram 
reporting? 

6. Did you observe all of the various export file formats for Crystal Reports Developer? 
Were you able to successfully export all of your report content? 

Contact us to provide feedback, comments, or questions about the features covered in 
this tour. 

 

Spell Checker, History, Notes, Printing, Transforms, Link 
Objects, and Navigation 

This section provides information about the following functional areas: 

Spell checker (see page 30) 

History and notes (see page 31) 

Microsoft Windows standard printer selection dialog (see page 31) 

Single state transformations (see page 32) 

Creating and working with Link objects (see page 33) 

Go To functionality (see page 33) 
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Spell Checker 

Use the following steps to become familiar with the Spell Checker functionality. 

1. Open one of your existing models or create a new model with a few entities. 
Right-click on any entity in the Model Explorer and select Properties to launch the 
Entity Editor. Click the Definition tab, and enter some text if there is not text already 

present. Make a deliberate spelling error. Click the Spell Check toolbar button  to 
launch the Check Spelling dialog. 

2. Click the Options command to launch the Spelling Options dialog. Explore the 
various options available and customize Spell Check according to your 
requirements. Save your changes and close the Spelling Options dialog by clicking 
OK. 

3. In the Check Spelling dialog, click the Dictionaries command to launch the Spelling 
Dictionaries dialog. Add a new word to your currently selected dictionary and 
define the associated Action. You can add or remove Dictionaries to your model 
from this dialog. 

 

4. At any time, launch the Help to further understand the meaning of all of the options 
available on the various dialogs for Spell Checker. 

5. Modify the misspelled word by double-clicking one of the words from the 
Suggestions list, or ignore the mistakes pointed out by the Spell Checker by clicking 
Ignore.  

Note: You can also add this word to your enterprise dictionary by selecting the 
dictionary from the Add Words To drop-down list and clicking Add. 

6. Close the Check Spelling dialog by taking an appropriate action for the misspelled 
word (like Ignore, Add, or Change). The Spell Checker facility is also available for 
Comments and Notes. 
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History and Notes 

Use the following steps to become familiar with history and notes. 

1. Open one of your existing models or create a new model with a few Entities. 
Right-click any Entity in the Model Explorer and select Properties to launch the 
Entity Editor. Click the Notes tab and notice that History and Notes properties have 
been consolidated. Have a look at all of the information presented on this tab. 

2. Click the Sort Items toolbar button  and select the Creation Date Descending 
sorting mechanism. Observe how the events are rearranged accordingly. Sort the 
events using the other sorting mechanisms as well, and select the one that best 
suits your requirements. 

3. Click the Filter toolbar button  to display both History and Notes, or either one of 
them. 

4. Click the New toolbar button  to launch the Notes Editor. Enter some text for the 
newly-created User Note, which will be displayed as a comment. Select some other 
Note or History item from the Navigation Grid, and modify the comment for the 
same in the text editor. Save your changes by clicking the Close button and observe 
the result of your actions in the Notes tab.  

5. Click Close to exit the Entity Editor. 
 

Windows Standard Printer Selection Dialog 

Use the following steps to become familiar with the Windows standard printer selection 
dialog support in CA ERwin Data Modeler. 

1. Open one of your existing models and launch the Page Setup dialog by clicking File, 
Page Setup.  

2. Click the General tab and specify the general page settings like page size, 
orientation, and so on. Click the Margins tab and specify the Header/Footer and 
Margins values to use for printing. Save these settings to the currently open 
diagram by selecting Save to Diagram, and then close the Page Setup dialog. 

3. Open the Diagram Editor and click the Page Setup or Page Setup Margins tab. Verify 
that the changes made to the page settings in Step 2 are reflected here as well. 
Close the Diagram Editor. 

4. Open the Page Setup dialog again, and make some changes to the General or 
Margins settings. Click Load from Diagram and notice that the settings from the 
current diagram are restored and override your changes. Select the Keep 
synchronized with current diagram option to keep the page setup and current 
diagram page style settings synchronized. Save the changes by closing the dialog. 
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5. Open the Overview pane and notice the grid view of the model content printed on 
each page. Open the Page Setup dialog again, and change the Zoom Level value to 
400 and click Close. Observe the corresponding changes to the grid view in 
Overview pane and increase in the number of pages required to print the diagram.  

6. Launch the Print Preview dialog by clicking File, Print Preview. Browse through all of 
the pages being printed according to the Print and Page Setup Options, using the 
Prev and Next page commands. Also explore the Zoom In and Zoom Out options. 
Close the Print Preview dialog. 

7. Click Print on the File menu (or press Ctrl+P) to launch the Print dialog. Select a 
printer from the drop-down and click the Properties button to launch the standard 
printer properties dialog. Press Cancel to close the printer properties dialog. You 
can also launch the Preview and Page Setup dialogs in the Print dialog to further 
customize the print settings. 

8. In the Print dialog, specify the Page Range that you want to print. Specify whether 
to print the diagram or selected objects, and specify the print order. 

9. Customize all the print options as needed, and click Print to begin printing. Compare 
the printed copy of the model with the actual diagram to notice if there are any 
differences. 

 

Single State Transformations 

Use the following steps to become familiar with single state transformations. 

1. Open one of your existing r7.x models containing live transforms. 

2. CA ERwin Data Modeler r8 launches the Model Upgrade Wizard that will help you in 
the model upgrade process. Read the Overview information before proceeding. 

3. Click Main Subject Area from the list on the left. Check the <Main Subject Area> 
Upgrade Options if you want to keep the Main Subject Area and its diagrams in the 
upgraded model. Also select the Apply a default theme to each diagram option to 
maintain theme consistency after the upgrade. 

 

4. Click Transforms from the list on the left hand side. Select from the options 
available one-by-one and read the associated information in the text box. For this 
tour, select the Resolve all transforms option and click Continue. 

5. The upgrade process completes successfully. Close the Post Load Upgrade dialog 
and note. 

6. In the Model Explorer, notice that no Transformation objects are created (as 
opposed to Transform objects in r7.x), and thus no live updates of source and target 
objects are maintained. In the diagram area, verify that all of the transforms have 
been resolved and only the target objects are visible. Close and save the model for 
later use. 
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Creating and Working with Link Objects 

Use the following steps to become familiar with creating and working with Link objects. 

1. Open an existing model, or create a new one with some entities and attributes. 
Select an attribute in one of the entities and launch the Attribute Editor. 

2. Click the Link tab and click the New icon on the toolbar to launch the Link Wizard. 

3. Read the information in the Overview page to understand the process of using the 
Link Wizard. 

4. Click the Link page from the list on the left side. Provide a Name and Definition for 
the Link Object created. Select the Synchronization Direction property as Two Way. 

 

5. Click the Target page from the list on the left side. Select the Target Owner Table 
and the Target Column for the link object. You can also create a new target column 
in the target table selected. 

6. Click the Properties page from the list on the left side. By default all of the 

properties are selected to synchronize between the two attributes. Click the  
button on the toolbar to unselect all of the items in the list, and select the 
properties that you would like to be synchronized. Save your selections as a new 
Option Set.  

7. Click the Apply button to close the wizard and return to the Attribute Editor that 
now contains the Link object details for that attribute. Close the Attribute Editor. 

8. Make some changes to the Properties of the source column, and verify that the 
changes are reflected in the properties of the target column. Similarly make some 
changes to the Properties of the target column, and verify that the changes are 
reflected in the properties of the source column. Close the model. 

 

Go To Functionality 

Use the following steps to become familiar with the Go To functionality. 

1. Open one of your existing models or create a new model with some entities, 
relationships, and shape objects. 

2. Press CTRL+G to launch the Go To dialog. Observe that this dialog now contains a 
complete listing of all the model objects in your model. Toggle the ‘Show Drawing 
Objects in List’ check box (top right corner of the dialog) to hide/unhide the drawing 
objects. Enter some text in the Enter filter text field, to filter the list of objects based 
upon the text entered.  

3. Select an entity, relationship, or shape object from the list and click the Go To 
button. Observe that the focus moves to the selected object on the diagram area. 
Feel free to explore the other commands on the toolbar. Close the Go To dialog. 

4. Right-click any entity or relationship in the diagramming area, and click Go To 
Model Explorer from the context menu. Observe that the same entity or 
relationship is selected in the Model Explorer. 
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Tour 5 Questions and Feedback 

Work with the following questions for Tour 5 to assess your understanding of the 
features. 

1. Did the Spell Checker work as expected? Was it able to detect/change or ignore 
misspelled words according to the spelling options you specified? Are there any 
other spelling options you would like to see in the tool? 

2. Does the Spell Checker provide you with the ability to create and use Enterprise 
Dictionaries? Were you able to create and use dictionaries in languages other than 
English, if that is a requirement? 

3. Apart from the Definition, Comment, and Notes tabs, are there any other places you 
would like the Spell Checker feature to be available? 

4. Does the Notes tab provide you with all of the information on the history and notes 
attached to the particular object? Are all of the menu options available on the 
Notes tab working as expected? 

5. Were you able to successfully print your model diagram according to the Page and 
Print settings? Did you face any challenges during the Print operation? 

6. Are there any other customizations to the Page and Print settings you would like in 
the tool? What are your print requirements that the tool is able to meet or not 
meet? 

7. How does the new Single State Transformation affect your models or workflow? Do 
you see any gain in the performance of CA ERwin Data Modeler as a result of this 
change? 

8. Based upon your exploration, how do you intend to use the Annotations object, as 
opposed to the traditional Rectangle drawing object? 

Contact us to provide feedback, comments, or questions about the features covered in 
this tour. 
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